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Rather than constructing diagrams from scratch, 
PowerPoint includes a range of SmartArt graphics that you 
can use. SmartArt includes a range of graphics to help you 
to build simple or complex diagrams, such as flow charts, 
process charts, organisation charts, to name only a few! 
Select a SmartArt graphic from the gallery and then 
customise it to suit your needs. SmartArt will help you to 
create professional-looking diagrams in minutes. 

In this booklet we will show you how to: 

 gain an understanding of SmartArt 

 insert a SmartArt graphic 

 insert text into a SmartArt graphic 

 add shapes below the active shape 

 add shapes above the active shape 

 add shapes before and after the active shape 

 add an assistant 

 promote and demote shapes 

 switch a SmartArt graphic from right to left 

 resize SmartArt 

 apply a different layout 

 apply a colour scheme 

 apply a SmartArt style 

 delete shapes from a SmartArt graphic. 

INFOCUS 
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UNDERSTANDING SMARTART 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SmartArt allows you to visually 
communicate your important ideas and 
information. For example, you can use 
SmartArt graphics to depict processes, 

hierarchies, relationships and so on. By 

using SmartArt to communicate information, 
you can create visually-appealing diagrams 
that can say so much more than words 

alone. 

How To Use SmartArt 

SmartArt can be a simple flowchart 
depicting a process or a complex 
arrangement of shapes and lines used 

to show relationships. To work with 
SmartArt, simply select a layout from 
the SmartArt gallery that most closely 
represents the way you want to 
structure your information, and then 
customise the SmartArt graphic by 
adding text and formatting shapes. The 

picture to the right is an example of a 
SmartArt graphic used to list a range of 
complementary fuels. Presented in this 
way, dry subject matter suddenly 

becomes an interesting read.   

The SmartArt Gallery 

SmartArt graphics are available from the SmartArt gallery. Click on a category in the 
left pane to view a range of layouts for that category in the centre pane. Click on a 
layout to preview it in the right pane. 

There are eight categories of SmartArt graphics in the SmartArt gallery. 

 List: For items without a sequence, such as a list of key objects or concepts. 

 Process: For items or steps with a specific sequence and end point. 

 Cycle: For steps with a continuing sequence. 

 Relationship: To illustrate relationships between things, such as objects and 
people. 

 Matrix: For grid-like diagrams. 

 Pyramid: For a hierarchy of items, like the traditional food pyramid. 

 Picture: To create picture galleries and collages, for example. 

 Office.com: Connect to office.com to view the layouts available to download.  
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INSERTING A SMARTART GRAPHIC 
 

 

 

 

  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Before starting this 
exercise you MUST open 
the file P810 
SmartArt_01.pptx... 

1 Click on Insert SmartArt 

graphic  in the content 

placeholder, or click on the 
Insert tab, then click on 

SmartArt  in the 

Illustrations group to 
open the Choose a 
SmartArt Graphic dialog 
box 

You will insert the graphic 
into the placeholder… 

2 Click on each category in 
the left pane, and then 
click on various layouts in 
the centre pane to preview 
each layout 

3 Click on Hierarchy in the 
left pane, then click on 
Organisation Chart in 
the centre pane to select 
this layout 

4 Click on [OK] to insert the 
SmartArt graphic 

The graphic is contained 
within a placeholder, and 

you can click in any [Text] 
placeholder and start 
typing 

 

For Your Reference… 

To insert a SmartArt graphic: 
1. Click on the Insert tab, then click on 

SmartArt  in the Illustrations 

group 
2. Click on a category in the left pane  

3. Click on a layout, then click on [OK] 

Handy to Know… 

 Among the numerous organisation chart 
layouts available in the SmartArt gallery 
is a Picture and Name Organisation 
Chart. If you insert this graphic, you will 
see picture placeholders. Click on a 

picture placeholder to open the Insert 
Picture dialog box, select the picture, 
then click on [Insert]. 

 

1 

4 

To create diagrams using SmartArt 
graphics, you first need to open the 
SmartArt gallery. You then select a layout 
from one of the eight categories that will 

best depict the information you want to 

convey. Once you insert the graphic, you can 
then insert text and format the shapes as 
required. Here you will insert an 
organisation chart. 
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INSERTING TEXT 
 

 

 

 

    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To insert text into a SmartArt graphic: 
1. Click on the SmartArt graphic to 

display the placeholder, then click on 

the tab   on the left edge of the 

placeholder 
2. Type the text, using the arrow keys to 

move between entries (shapes) 

Handy to Know… 

 You can also display and hide the Text 
pane by clicking in the graphic to 
activate the placeholder, then clicking 

on Text Pane  in the Create 

Graphic group on the Design tab. 

1 

2 

Text is inserted into text placeholders, 
which contain the text within the 
corresponding shape. There are two ways 
to insert text into a SmartArt graphic: 

click on the [Text] placeholder and start 

typing, or display and type your text into the 
Text pane. Inserting text into the Text pane 
is generally the quicker method, as you don’t 
need to move to each shape before you type 

your text. 

3 

5 

Try This Yourself: 

S
a
m

e
 

F
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Continue using the previous 
file with this exercise, or open 
the file P810 
SmartArt_02.pptx... 

1 Click on the SmartArt 
graphic to display the 
placeholder if it is not already 
displayed, then click on the 

tab  on the left edge of the 

placeholder to open the Text 
pane 

The tab will expand to open 
the Text pane, where each 
bullet point corresponds to a 
shape in the graphic... 

2 Click on the first bullet point 

and type Managing Director 

The text will also appear in 
the corresponding shape in 
the chart. Notice also how the 
font size adjusts 
automatically... 

3 Press  to move down to the 

next bullet point (assistant) 
and type Legal Advisor 

4 Repeat step 3 to add the 
following entries: 

Administration Manager 

Financial Controller 

Marketing Director 

5 Click on close  at the top of 
the Text pane to close the 
Text pane 
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ADDING SHAPES BELOW 
 

 

 

 

      

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
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e
 Continue using the previous file 

with this exercise, or open the 
file P810 SmartArt_03.pptx... 

1 Click on the text Managing 
Director to make the shape 
active 

A dashed blue line will appear 
around the shape, indicating it is 
active, or editable. You will add a 

shape one level below the active 
shape... 

2 Click on the SmartArt Tools: 
Design tab, then click on the 

drop arrow  for Add Shape  

in the Create Graphic group 
and select Add Shape Below 

The shape will be inserted a level 
below and will be active so you 
can start typing... 

3 Type Business Development 

You will now add the Accountant 
and Projects Officer, who reports 

to the Financial Controller… 

4 Click on the text Financial 
Controller to make the shape 
active, then click on the drop 

arrow  for Add Shape  in 

the Create Graphic group and 
select Add Shape Below 

5 Type Accountant, then repeat 
step 4 to add a shape below 
Accountant titled Projects 
Officer 

 

For Your Reference… 

To add a shape below: 
1. Click on the source shape to make it 

active 

2. Click on the drop arrow  for Add 

Shape  in the Create Graphic 

group  

3. Select Add Shape Below  

Handy to Know… 

 You can add shapes below by typing 
into the Text pane, which inserts the 
corresponding shape into the graphic. 
To do this, open the Text pane, then 
click at the end of the text entry of the 
source shape. Press  to add a 

shape (bullet point) below it, then 
press  and type the text. 

2 

4 

Although the range of SmartArt layouts 
make for a great start when creating 
diagrams, it’s likely that you’ll need to 
customise the graphic to meet your needs. 

One way to customise SmartArt is to add 

shapes to the existing graphic. You can add 
shapes below the active (source) shape, 
which appear below the active shape as 
being one level down in the hierarchy. 

5 
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ADDING SHAPES ABOVE 
 

 

 

 

      

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
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Continue using the 
previous file with this 

exercise, or open the file 
P810 SmartArt_04.pptx... 

1 Click on the text 
Managing Director to 
make the shape active 

You will add the CEO to 
the hierarchy… 

2 Click on the SmartArt 
Tools: Design tab, then 

click on the drop arrow  

for Add Shape  in the 

Create Graphic group and 
select Add Shape Above 

3 Type Chief Executive 
Officer 

4 Click on the text 
Administration Manager 
to make the shape active 

You will add the General 
Manager to the hierarchy… 

5 Click on the drop arrow  

for Add Shape  in the 

Create Graphic group and 
select Add Shape Above 

6 Type General Manager 

 

For Your Reference… 

To add a shape above: 
1. Click on the source shape to make it 

active 

2. Click on the drop arrow  for Add 

Shape  in the Create Graphic 

group  

3. Select Add Shape Above 

Handy to Know… 

 You can add shapes above by 
inserting text into the Text pane. To do 
this, open the Text pane, then click at 
the beginning of the bullet point entry 
of the source shape. Press  to 

insert a new entry, then press , then 

press  +  to promote the entry 

(one level up), then type the text. 

2 

5 

When you add a shape above, the shape 
will appear as one level above the active 
shape in the hierarchy. So, to add a higher 
position to an organisation chart, you will 

click on or select the source shape (that 

is, the starting shape that you will add other 
shapes to) and then add a shape above it. 
Here you will add the CEO and General 
Manager to the hierarchy. 

6 
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ADDING SHAPES BEFORE AND AFTER 
 

 

 

 

    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
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Continue using the previous 
file with this exercise, or 

open the file P810 
SmartArt_05.pptx... 

1 Click on the text Business 
Development to make the 
shape active 

You will add Sales Manager 
to the hierarchy… 

2 Click on the SmartArt 
Tools: Design tab, then 

click on the drop arrow  

for Add Shape  in the 

Create Graphic group and 
select Add Shape Before 

3 Type Sales Manager 

4 Click on the text 
Administration Manager 
to make the shape active 

You will add Office Manager 
to the hierarchy, who also 

reports to the General 
Manager… 

5 Click on the drop arrow  

for Add Shape  in the 

Create Graphic group and 
select Add Shape After 

6 Type Office Manager 

 

For Your Reference… 

To add a shape before or after: 
1. Click on the source shape to make it 

active 

2. Click on the drop arrow  for Add 

Shape  in the Create Graphic 

group  
3. Select Add Shape Before or Add 

Shape After 

Handy to Know… 

 If you’re not satisfied with the position 
of the shape when you Add Shape 
Before or After, you can click on 

Move Up  to move the shape across 

one position to the left, or click on 

Move Down  to move the shape 

across one position to the right.  

 

2 

5 

As well as adding shapes to your 
SmartArt graphic that appear above and 
below the active shape in the hierarchy, 
you can also add shapes to appear either 

to the right or the left of the active shape, 

that is, before or after the active shape. 
When you add shapes before or after the 
active shape, the entry will appear on the 
same level of the hierarchy as the active 

shape. 

6 
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ADDING AN ASSISTANT 
 

 

 

 

      

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
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Before starting this 
exercise you MUST open 

the file P810 
SmartArt_06.pptx... 

1 Click on the text 
Managing Director to 
make the shape active 

You will add an Executive 
Assistant to the Managing 
Director… 

2 Click on the SmartArt 
Tools: Design tab, then 

click on the drop arrow  

for Add Shape  in the 

Create Graphic group and 
select Add Assistant 

3 Type Executive Assistant 

4 Click on the text Sales 
Manager to make the 
shape active 

You will add Customer 

Service Reps… 

5 Click on the drop arrow  

for Add Shape  in the 

Create Graphic group and 
select Add Assistant 

6 Type Customer Service 
Reps 

 

For Your Reference… 

To add an assistant: 
1. Click on the source shape to make it 

active 
2. Click on the drop arrow for Add Shape 

 in the Create Graphic group  

3. Select Add Assistant 

Handy to Know… 

 By default, assistants are placed one 
level below the active shape and 
appear on the left of the connecting 
line. Subordinate positions appear on 

the right of the connecting line. 

2 

5 

An assistant, such as an Executive 
Assistant, generally reports to the CEO or 
Managing Director, but is not at the same 
level as other subordinates. For example, 

the CEO may have an Executive Assistant 

as well as other managers who report to 
them. For this reason, PowerPoint provides 
the Add Assistant tool to help account for 
these types of positions in the hierarchy. 

6 
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PROMOTING AND DEMOTING SHAPES 
 

 

 

 

    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To promote or demote positions: 
1. Click on the source shape to make it 

active, and then: 

 Click on Promote   

or 

 Click on Demote  

Handy to Know… 

 You may not get what you expect when 
promoting and demoting positions in a 
hierarchy, as this exercise has shown. 
Sometimes it may just be easier to 
delete the existing position and then 

recreate it in the correct position. 

2 

4 

Microsoft PowerPoint allows you to 
promote and demote shapes (or 
positions) in the hierarchy. This can save 
you from having to delete and recreate 

positions. When you promote or demote a 

shape in the hierarchy, any shapes below 
that shape are also promoted or demoted 
accordingly, and will move up or down one 

level in the hierarchy. 

7 

Try This Yourself: 

S
a
m

e
 

F
il

e
 Continue using the previous file 

with this exercise, or open the 

file P810 SmartArt_07.pptx... 

1 Click on the text Projects 
Officer 

The Projects Officer actually 
reports to the Accountant… 

2 Click on the SmartArt Tools: 
Design tab, then click on 

Demote  in the Create 

Graphic group 

The connecting line changes 
accordingly… 

3 Click on the text Marketing 
Director 

The Business Development and 
the Sales Manager actually 
report to the Marketing 
Director… 

4 Click on Promote  in the 

Create Graphic group 

This is not right at all! The 
reporting structure is a mess… 

5 Click on Demote  or press 

 +  to undo the change 

We will try another approach… 

6 Click on the text Sales 
Manager, then click on  

Demote  in the Create 

Graphic group  

7 Repeat the above step to 
demote Business 
Development 
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SWITCHING SMARTART RIGHT TO LEFT 
 

 

 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
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Continue using the 
previous file with this 

exercise, or open the file 
P810 SmartArt_08.pptx... 

1 Click anywhere on the 
graphic so that the graphic 
placeholder appears if it is 
not already displayed 

2 Click on the SmartArt 
Tools: Design tab, then 

click on Right to Left  

in the Create Graphic 
group 

The chart will be reversed. 
This layout is looking much 
better, let’s just double-
check that we want to use 
this layout… 

3 Click on Right to Left 

again to restore the 

original layout 

The other layout is 

preferable… 

4 Click on Right to Left  

again to reinstate the 
change, then click outside 
the placeholder to view the 
result 

 

For Your Reference… 

To switch right to left: 

1. Click on the SmartArt graphic to 
display the graphic placeholder 

2. Click on the SmartArt Tools: Design 

tab, then click on Right to Left  in 

the Create Graphic group 

Handy to Know… 

 Right to Left  is ideally suited for 

cycle and process diagrams, where it 
can be used to reverse the order of the 

process. 

2 

4 

The Right to Left tool allows you to switch 
the order of shapes in your SmartArt 
graphic. This is really the same as flipping 
or reversing the graphic. This also applies 

to any arrows that may appear in the 

graphic. So, whatever appeared on the left 
now appears on the right and so on. Note 
that you can only flip or reverse the entire 
graphic, not parts of the graphic. 
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RESIZING SMARTART 
 

 

 

 

    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a
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Continue using the 
previous file with this 

exercise, or open the file 
P810 SmartArt_09.pptx... 

1 Click on the SmartArt 
graphic to make it active 

We really cannot make the 
graphic wider, but we’ll 
increase the height by 
dragging on a placeholder 
border… 

2 Move the pointer over the 
placeholder handle that 
appears along the middle 
of the bottom placeholder 
border so that a double-
headed arrow appears, as 
shown 

3 Click and drag down 
slightly, as shown 

4 Release the mouse button 

The graphic is resized. You 
will use the controls on the 
Format tab to resize the 
height more precisely… 

5 Click on the SmartArt 
Tools: Format tab, then 
click on the up arrow  for 
Height in the Size group 
until the height is 14 cm 

 

For Your Reference… 

To resize SmartArt: 
1. Click in the SmartArt graphic to 

activate it 
2. Click and drag on a placeholder handle 

to resize, or click on the SmartArt 

Tools: Format tab, then specify the 
required Height and Width in the 

Size group 

Handy to Know… 

 Press  while dragging on a 

placeholder handle to resize from all 
four sides at once. 

 You may need to reposition the graphic 
once resized. To position SmartArt, 

click in the graphic, then click on Align 

 on the SmartArt Tools: Format 

tab and select an option. 

2 

3 

By default, SmartArt will resize 
automatically to fit the placeholder and 
vice versa. So, as you add or delete 
shapes, for example, the graphic will 

adjust its size accordingly to fit the 

placeholder. However, you may want to 
increase or decrease the size of the graphic, 
and there are a couple of ways to do this: 
either drag on a placeholder handle, or 

specify the width and height. 

5 
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CHANGING THE SMARTART LAYOUT 
 

 

 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a
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Continue using the 
previous file with this 
exercise, or open the file 
P810 SmartArt_10.pptx... 

1 Click on the SmartArt 
graphic to display the 
graphic placeholder and 
make it active 

2 Click on the SmartArt 

Tools: Design tab, then 

click on More  in the 

Layouts group to display 
the gallery of available 
layouts 

The current layout is 
outlined in yellow... 

3 Point to different layouts to 
see the organisation chart 
reformatted in Live 
Preview 

The name of each layout 
will be displayed in a tool 
tip... 

4 Click on Hierarchy to 
apply this layout 

 

For Your Reference… 

To apply a different layout: 
1. Click on the SmartArt graphic to 

activate it 
2. Click on the Design tab, then click on 

More  in the Layouts group 

3. Click on a layout to apply 

Handy to Know… 

 To view the full range of SmartArt 
layouts when choosing a different 
layout, click on the graphic to activate 
it, then click on the Design tab, click 

on More  in the Layouts group and 

select More Layouts. The SmartArt 
galley will be displayed. Select an 
alternative layout, then click on [OK]. 

2 

4 

Each SmartArt category in the SmartArt 
gallery contains a range of layouts that 
you insert to create your diagrams. But if 
you’re not happy with the layout you can 

easily apply a different layout to your 

existing graphic. The shapes and text will 
reformat in line with the selected layout, and 
changing the layout will not affect the 

structure of the diagram. 
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APPLYING A COLOUR SCHEME 
 

 

 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
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Continue using the 
previous file with this 

exercise, or open the file 
P810 SmartArt_11.pptx... 

1 Click on the SmartArt 
graphic to display the 
graphic placeholder and 
make it active 

2 Click on the SmartArt 
Tools: Design tab, then 
click on Change Colours 

 in the SmartArt 

Styles group to display a 
gallery of colour schemes 
(or themes) 

The currently-applied 
colour theme, Coloured Fill 
– Accent 1, is outlined in 
yellow... 

3 Point to different colour 
themes to see the 
SmartArt update in Live 
Preview 

4 Click on Colourful – 
Accent Colours to apply 
the colour scheme, then 
click outside the 
placeholder to view the 
result 

5 Save the presentation 

 

For Your Reference… 

To apply a colour scheme: 
1. Click on the SmartArt graphic to 

activate it 
2. Click on Change Colours  in the 

SmartArt Styles group 
3. Click on a colour scheme to apply 

Handy to Know… 

 You can modify the format of individual 
shapes, lines and the text within the 
graphic. To do this, click on a shape or 
line to select it (press  and click to 

select multiple shapes), or select the 
text, then click on the Format and 
Home tabs and apply formatting as 
required. 

2 

4 

There will be options for changing the 
default colour scheme. There are many 
other colour schemes that you can apply to 
your SmartArt to ensure, for example, that 

the graphic conforms to the formatting 
requirements of the presentation. 
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APPLYING A SMARTART STYLE 
 

 

 

 

  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
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Continue using the 
previous file with this 

exercise, or open the file 
P810 SmartArt_12.pptx... 

1 Click on the SmartArt 
graphic to display the 
graphic placeholder and 
make it active 

2 Click on the SmartArt 
Tools: Design tab, then 

click on More  in the 

SmartArt Styles group to 
display the gallery of styles 

Word suggests a range of 
styles that best match the 
current document… 

3 Point to different styles to 
see the SmartArt Style 
change in Live Preview 

You may need to wait a 
moment for Live Preview 
to display the effect, as 3D 
effects can be quite 

memory-intensive… 

4 Click on Moderate Effect 
to apply this style, then 
click outside the 
placeholder to view the 
result 

5 Save the presentation 

 

For Your Reference… 

To apply a SmartArt Style: 
1. Click on the SmartArt graphic to 

activate it 
2. Click on the Design tab, then click on 

More  in the SmartArt Styles group 

3. Click on the desired style to apply it 

Handy to Know… 

 You can reset a SmartArt graphic to its 
original form (that is, the original 
layout). This will remove any 
formatting, such as styles and colour 
schemes.  To do this, activate the 

graphic, click on the Design tab and 

then click on Reset Graphic . 

2 

4 

You can also apply styles to your 
SmartArt. Styles differ to layouts in that 
they include a range of effects for shapes, 
such as 3D effects, thereby enhancing the 

look of your graphic. 
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DELETING SMARTART SHAPES 
 

 

 

 

    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To delete a shape from SmartArt: 
1. Click on the border of the shape to 

select it 
2. Press  or    

Handy to Know… 

 To delete multiple shapes at once, 
press  and click to select multiple 

shapes, then press .  

 To delete the entire SmartArt graphic, 
activate the graphic, click on the 

placeholder border to make sure no 
shapes are selected, then press .  

1 

2 

You may also need to edit the graphic, 
such as deleting individual shapes or 
editing text. When you delete shapes in a 
SmartArt graphic, the graphic will adjust 

accordingly. Any lines connecting to that 
shape will also be removed. 

4 

Try This Yourself: 

S
a
m

e
 

F
il

e
 

Continue using the previous 
file with this exercise, or open 

the file P810 
SmartArt_13.pptx... 

1 Click on the text Legal 
Advisor to activate the 
shape, then click on the 
border of the shape to select 
it, as shown 

Handles should appear 
around the shape but the 
cursor should not appear in 
the text... 

2 Press   

The shape will be deleted and 
the graphic will adjust 

accordingly... 

3 Repeat step 1 to select the 
shape titled Office Manager 

4 Press   

You will now edit some of the 
text… 

5 Click on the text 
Development (for Business 
Development), then press 

 to move to the end of the 

text 

6 Press  then type 

Manager 

7 Click outside the graphic to 
deselect it and view the result 

8 Save and close the 
presentation 
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CONCLUDING REMARKS 

 

 

 

 

Congratulations!  

You have now completed the SmartArt booklet.  This booklet was designed to get you to 
the point where you can competently perform a variety of operations as outlined in the task 
list on page 2. 

We have tried to build up your skills and knowledge by having you work through specific 
tasks. The step by step approach will serve as a reference for you when you need to repeat 
a task. 

 

Where To From Here… 

The following is a little advice about what to do next: 

 Spend some time playing with what you have learnt. You should reinforce the skills 
that you have acquired and use some of the application's commands. This will test 
just how much of the concepts and features have stuck! Don't try a big task just yet if 
you can avoid it - small is a good way to start. 

 Some aspects of the course may now be a little vague. Go over some of the points 
that you may be unclear about. Use the examples and exercises in these notes and 
have another go - these step-by-step notes were designed to help you in the 

classroom and in the work place! 

Here are a few techniques and strategies that we've found handy for learning more about 
technology: 

 visit CLD’s e-learning zone on the Intranet  

 read computer magazines - there are often useful articles about specific techniques 

 if you have the skills and facilities, browse the Internet, specifically the technical 

pages of the application that you have just learnt 

 take an interest in what your work colleagues have done and how they did it - we 
don't suggest that you plagiarise but you can certainly learn from the techniques of 
others 

 if your software came with a manual (which is rare nowadays) spend a bit of time 
each day reading a few pages. Then try the techniques out straight away - over a 
period of time you'll learn a lot this way 

 and of course, there are also more courses and booklets for you to work through 

 finally, don’t forget to contact CLD’s IT Training Helpdesk on 01243-752100 
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